
 

Dreamweaver MX – Tables and Layout Tools 
 
Creating a web page using the table and layouts tools provides ultimate flexibility in the design 
and planning stage.  Use the table and layout tools to place content and images exactly where 
you want them in a web page. 

Site Management 
Site Management is a mechanism used to keep track of web pages you build for a specific web 
project and the assets you use in them.  Think of  Site Management as a holding tank or a central 
storage location for all related files, also known as a  Root Folder. 

Creating and Defining a Site 
Create a Site prior to building any pages for your web project.  The Site you create will have a 
unique name and a storage folder, Local Root Folder, which will be used to hold all the related 
pages for the web project.   Note, all items used in your web project must be stored in the 
specified Local Root Folder, which you specified within the Site for the project. 
 

From the Menu toolbar select Site, New or Press the shortcut key F5  to open the Site Definition 
dialog box. 
Tip:  Select the Advanced tab to bypass the Basic Wizard setup. 
 

Specify a Site Name by clicking with 
the mouse in the Site Name field.   
 
The Site Name is an internal naming 
convention.   When naming the Site, 
don’t worry about spaces or 
capitalization.   The Site Name is 
like a “pet name” for your project.  
The Site Name is never transferred 
to the Web or Remote server. 
  
Select the Folder icon to the right of 
the Local Root Folder field to create 
a new Local Root Folder or browse 
and select the folder that will hold 
the web site and be known as the 
Local Root Folder. 
 
All files and assets that you plan on 
using in your web project must be 
stored in the Local Root folder. 
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When back to the Site Definition dialog box the Local Root Folder should display the folder 
name just created or selected.   
 
All the files and subfolders that you use for your Site should be stored in the specified Local 
Root folder so that when you create your pages, the graphics and links are relative to the that 
folder.  When you get ready to publish, you will only need to copy the root folder, which will 
contain all files and subfolders, and copy (Put) them on the Remote Server (Web Server) from 
your Local computer.   
 
When you Put your Site on the Remote Server, Dreamweaver will maintain an identical 
directory structure as your Local Root to ensure links and references work.   
 
New to MX:  The Site dialog box needs to know where all the images are stored within your 
Site.  Use the Default Images Folder field to point to the folder within your Local Root Folder 
that will contain or hold all images for the files within the web project specified in the Site dialog 
box.  Note, if you don’t have a folder created for your images, then click with the mouse on the 
Folder icon to the right of the field and create a new folder to house the images. 
 
From the Site Definition dialog box be sure to select the Refresh Local File List Automatically 
so that Dreamweaver updates the site list when it has been modified.    
 
From the Site Definition dialog box be sure to select the Enable Cache .  This feature will create 
a cache that will help increase the speed for link management while working in Dreamweaver.  
The Site is now defined.   
 
 
 

Browser Preview 
Dreamweaver is a WYSIWYG program, meaning what you see is what you get.  However, it’s 
still a good idea to view your page in different browsers prior to publishing to make sure they 
look good.  Dreamweaver lets you set your preferences and specify the browsers you want to 
preview your creation in.  Dreamweaver preferences can hold up to twenty different browsers, 
but the two most common are Netscape Navigator and Internet Explorer.  Note:  you must have 
these programs installed on your computer before you may use the preview option.  Both 
browsers may be downloaded from the Internet. 
 
 Netscape Navigator  à http://home.netscape.com/computing/download/  
 Microsoft Internet Explorer à http://www.microsoft.com/windows/ie/ 
 
The Preview in Browser option is located in the File menu or in the Document toolbar.  From the 
File menu select Preview in Browser and select a browser from the fly-out menu.  The Preview 
in Brower icon located in the Document toolbar works the same way. 
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The shortcut key for the browser is located to the right of the browser name in the Preview in 
Brower fly-out menu.   For example, to launch the Preview in Browser using the Internet 
Explorer browser, press F12. 
 
Adding  Browsers  
To add or delete a browser, choose Edit, Preferences,   and 
select the Preview in Browser category.  From the Preview 
in Browser dialog box, select the Plus icon to add a new 
browser or the Minus icon to remove a browser. 
 
Tip:  Internet Explorer is the default primary browser.   
 
 
 

Creating A Basic Web Page 
Dreamweaver opens with an empty 
window, ready to create or open a 
document.  To open a new window 
choose  File,  New.      
 
Select the Basic Page Category and 
the HTML Basic Page from the New 
Document dialog box. 
 
Press the Create button to generate 
the new page. 
 
 
 
 
 

Saving Your File   
Always save your document as soon as you open a new document by choosing File, Save As.   
Name your files with meaningful file names and use lowercase letters or numbers for your file 
names.  Note, when naming and saving your files don’t use spaces in your file names; instead 
use the underscore or dash.  Dreamweaver automatically adds the extension .htm to your file 
name when you save.   You can change the file extension by choosing  Edit, Preferences and 
change the Add Extension When saving option from the General Category.   
 

Adding a Title  
Always give every HTML document a title.  The document title appears in the title bar of the 
Dreamweaver window and the browser title bar.   It’s important to give your title a meaningful 
name because the title name will be used as a browser bookmark or favorite.   
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A title can be added by using the Title field in the Toolbar 
 
 
 
or by choosing  Modify, Page Properties.    Page Properties can also be accessed by right-
clicking with the mouse and selecting Page Properties from the menu. 
 
Notice  (untitled-1*) appears to the right of the page title.  This text is displayed because the file 
hasn’t been saved yet.  Once the file has been saved the (untitled-1*) will change to display 
filename. 
 
 

Modifying Page Properties 
Page Properties include the title, background color, background image, text color and hyperlink 
color.  Choose Modify, Page Properties to edit properties. 
 

Selecting Color 
There are 216 web safe colors and 213 of the web safe colors appear the same in Netscape and 
Internet Explorer browsers on both Windows and Macintosh operating systems.    Dreamweaver 
will replace the non-web safe web color with the closest web safe color when the Snap to Web 
Safe option is selected when choosing a color from Windows OS, Mac OS or Grayscale color 
palette.  Creating or using a custom color, which isn’t displayed in the color-safe palette, could 
have an adverse appearance in some browsers.    
 
The cursor icon changes to an Eyedropper and it is used to select colors from the color-palette.  
You can also use the Eyedropper to select any color displayed on your desktop.  The Eyedropper 
will pick up the color and display it in the Current Color box.    As you move the cursor over the 
color swatches the color that your cursor is resting on will display in the upper left hand corner 
of the color-picker box.   The hexadecimal number for the color will be displayed to the right of 
the color swatch.    

 
Located in the upper right corner of the color palette are two icons.  

The first icon is the Strikethrough button and is used to clear the current color without choosing a 
new color.   The second icon is the Color Wheel button and is used to create custom colors.   
 

Background Color   
The background default color of a web page is white.  To change the background color choose 
the Background option from the Page Properties dialog box or use the shortcut key Ctrl+J to 
access the Page Properties dialog box.    Remember to use light colored text if you choose a dark 
background.  NOTE:  Background images override background color. 
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Text Colors  
 
Click on the color swatch to the right of Text Color to select a color, which will return you to the 
Page Properties dialog box.   If you know the hexadecimal number for the color, you may type it 
directly in the Page Property dialog box to the right of the Text Color field. 
 

Link Colors  
Use the Page Properties dialog box to change colors for the Links, Visited Links and the Active 
Links.  The link colors chosen from the Page Properties dialog box will apply to the entire 
document. 
 
Types of Links: 

The Links option is the initial color of a hyperlink, the color a user sees before clicking the link.  
The default browser color of Links is Blue. 
 
The Visited Links option is the color the link changes to when a user clicks on the link.  The 
default browser color of the Visited Link is Purple. 
 
The Active Link option is the color the link changes to while the user holds down the mouse 
button after clicking the link.  The default browser color of the Active Link is Red. 

 

Page Margins  
Margin tags were new in Dreamweaver 3 and work with version 4.0 of Netscape and Internet 
Explorer or later.   
 
To access the Page Margins choose Modify, Page Properties or use the shortcut key Ctrl+J.  
Notice there are four different types of margins to create.  Set the left margin and margin width 
to the same number and set the top margin and margin height to the same number if you want 
your pages to appear similar in both browsers, Netscape and Internet Explorer.   
 
Note:  Left Margin and Top Margin are supported by Internet Explorer 4.0 or later. 
Note:  Margin Width and Margin Height are supported by Netscape Navigator 4.0 or later. 
 

Tip: Omit the Offset 
Set page margins to zero to omit the offset between the way foreground and background images 
are displayed in html pages on Netscape and Internet Explorer.    Select a different Window Size, 
located in the status bar, to see how your text looks with your margin settings.   
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Preset Color Scheme 
Dreamweaver provides preset color schemes for the background, text, and links.  A Color 
Scheme can be applied to a page at anytime by choosing   Commands, Set Color Scheme. 
Tip:  Color Schemes cannot be created from the Set Color Scheme dialog box. 

 

Adding Text  
There are several different ways one can insert text on a web page in Dreamweaver.  One could 
type the text directly on the canvas, copy text from a different file and paste it into the canvas, 
import a text file, or even import a web page that was created in Microsoft Office. 
 

Typing Text Directly on the Canvas 
Position the cursor on the canvas and type the text.  Use the Properties Inspector to format the 
text by adding headings, font styles, colors and more. 
 
 

Formatting Text 
 
Formatting options are located in the Property Inspector.  Access the Property Inspector by 
choosing   Window,  Properties or use 
the shortcut key Ctrl+F3.   
 
The fields in the Properties Inspector 
are Context Sensitive and will change 
to reflect properties to what is being used in the table.  For example, if you are working with an 
image, then the Properties Inspector will change to reflect image properties. 

Inserting Tables 
 
Many web page designers use tables as a way to organize text and objects because tables offer 
many features such as varied colors for the table background, row, column or even a cell.  A 
table can even be nested inside an existing table and cell, row and column sizes can vary.  The 
user can decide where the table will be located on the page and whether or not the table should 
have a border.   
 

• The Table icon is located in the Insert Panel under the Common tab. 
 

• From the Common tab select the Insert Table icon 
or from the Insert menu choose Table 
(shortcut key  Ctrl+Alt+T). 
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The Table dialog box will appear. 
 

• Select the number of Rows and Columns.   
 

• Width à choose either percent or pixels.   
 

o Percent will adjust the table to fit a specific percentage of the end users window.   
o Fixed will create a table to a specific size.  The Fixed table, specific pixels, will 

not adjust to fit the end users window. 
 

• If a table is created with a Border equal to one, then the border on the table will display at 
one pixel wide in the web browser.  Use a Border equal to Zero if you plan on not 
displaying the table borders in your design.  

 
• Cell Padding and Cell Spacing.  This is an option that will need to be played with.  Adjust 

the cell padding and spacing according the need and desired look.   
o Cell Padding equals the amount of padding around the borders.  
o Cell Spacing equals the amount of spacing between cells. 

   
Example of a table with no padding or spacing: 
 
 
 
 
 
Example of the same table with spacing and padding set to 4. 
 
 
 
 
 
 
Notice how the text doesn’t align exactly with the borders in Example #2 as it did in Example 
#1.   
 
 

• The Align field by default is set up to align the table left on the page.  Change the Align 
option for the table by selecting the table border and choosing an option from the Align 
pull-down menu. 

 
• Choose OK when finished. 
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Formatting Options for a Table 
 
When a table, column, row, or cell is selected the Property Inspector will change to display the 
corresponding properties.   
 
Table Properties 
 

 
 
 
 
 
 
 

 
Cell Properties 

 
 
 
 
 
 

 
Regular text Properties Inspector 

 
 
 
 
 
 
 

 
 
 
Formatting the Table, Cell and Border  
Manually set the color scheme for your table with the Property Inspector or select a preset table 
color scheme by selecting the table and choosing  Command  |  Format Table.   
 
 
Table Properties:  Adding a Row or Column 
 

• The easiest way to add a row or column is to first select the table border and second, 
change the number of rows or columns in the Properties Inspector.   

• The Modify, Table menu will also work to add a row or column to an existing table.   
Note: when deleting a row, position the cursor in the cell when using this option.    
If the border is selected, the Table menu options will not be available. 
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Table Properties:  Deleting a Table, Row or Column 
 
There are several different ways one can delete a cell, row or column within a table.   
 

• Choose Modify, Table, and select an option from the Table menu.  Note: when deleting a 
row, position the cursor in the cell when using this option.  If the border is selected, the 
Table menu options will not be available. 

• Right-click in the table and select Table, and the Delete option.  
• Select the table tag in the status bar and press delete key.   

 

Cell Properties 
 
Merge or Split a Cell   

Position the cursor in the cell and select either Merge or Split from the properties inspector.   
 
Cursor Alignment for the Cell   

• Use the Horizontal menu to align the text left, center or right in the cell.  Default is Left. 
• Use the Vertical menu to align the text top, middle, or bottom in the cell.  Default is 

Center. 

Cell Width and Height 
 

• Use a percent amount if you want the cell to change or resize  
• Use a pixel amount if you want a fixed cell size  

 
Tip:  Leaving the Height field blank will allow the cell to automatically adjust its contents. 
 
 
No Wrap   
By default, the text is set up to wrap in a cell.  Select the No Wrap option if you do not want text 
to wrap in a cell.   
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Images 
The two standard images types that most browsers support are GIF and JPEG.   
 

• GIF (CompuServe Graphics Interchange Format  - GIF extension)  
• JPEG (Joint Photographic Experts Group - JPG or JPEG extension)  

 
GIF art images lack the higher quality of JPEG files, but are more compact and display more 
quickly in web browsers.  GIF images work well for black and white "wireframe" or line 
drawings while JPEG images are more appropriate for "raster" or full color images (such as 
photographs). 
 
For Your Information: 

A new image format called PNG (pronounced “ping”) is becoming a replacement for GIF 
images.  PNG supports alpha channels that are useful for transparency.  Microsoft Internet  
Explorer 4.0 and Netscape Navigator 4.0 both display PNGs but have difficulty with alpha 
channels and some of the more advanced characteristics of this format. 
 
 
You can create your own images, scan them, or buy them as part of a commercial clip art 
package. You can also find GIF and JPEG images in the Internet's many image archives. 
 

Inserting an Image 
 
***Save your page first. Place the cursor where you want to insert the image.   From the Insert 
Menu choose Image and browse to select the image.   An image can also be inserted by choosing 
the Image icon from the Common Tab located in the Inset Bar. 

 

Alternative Text  
Alternative text can be displayed in place of an image. You should specify alternative text for 
those readers who use text-only browsers or have image loading turned off.  In addition, use of 
alternative text allows visually impaired users who use speech synthesizers to read text on a web 
page.  When inserting alternative text, be sure to use descriptive text for the images.   For 
example, alternative text which reads “a car” is not as descriptive as “a blue 1965 Ford 
Mustang”.   Use alternative text to give meaning to your image so the information is accessible 
to all users.  Most browsers display the alternative text as a tool tip when the mouse rolls over the 
image. 
 
Adding Alternative Text: 

Select the image and the Property Inspector palette will change to display image properties.   
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Position the cursor in the Alt field and type the alternative text. 
 

Image Alignment 
Select the image and choose the Left, Center or Right Align buttons from the Property Inspector 
to move the image.   

 

Text and Image Alignment 
The Align field located on the Property Inspector lets you control the way text will appear 
around your image.  The default setting for the Align option is Browser Default, which is the 
same as baseline alignment.   
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Cell Layout Tool 
Dreamweaver 4/MX has a tool called the Cell Layout tool.  The Cell Layout tool is similar to a 
cell in a table.  The Cell Layout tool allows you to draw boxes on your web page that can hold 
objects or text in place.   
 
Use the Cell Layout Tool to design your web page.  Draw cells on the canvas where you plan to 
insert images and text as placeholders and then go in and insert images and text.   
 

Using the Cell Layout Tool 
 

• Select the Layout tab from the Insert Panel.  Note the Default view is the Standard View.  
Select the Layout view button to access the layout tools.   

 
 
 
 

 
• When the Layout View icon is selected, a dialog box will display explaining how the 

Layout and Standard View work. 
 

• Select the Draw Layout Cell icon to draw a cell on the page.    
Left-click the mouse and drag the mouse to draw a cell.  The   
cell will display in the color blue. 

 
• Notice that Dreamweaver creates a table in the background to house the cell that you 

draw.  The table in the background will display in the color green and will be tagged 
Layout Table. 

 
• Select a cell to resize or drag to a new area on the page.  A selected cell will display in 

the color blue.  Note the Property Inspector can also be used to change the cell properties. 
 

• Select a cell and use the Properties Inspector to change cell properties such as the 
background color of the cell. 

 
• To delete a cell select it and press delete. 
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Autostretch 

Use the Auto Stretch option for a column if you want 
Dreamweaver to resize the table to fit the browser 
window.  From the Layout view, select the column that 
should be adjusted for Auto Stretch.  Next, select the 
“green arrow” pointing down over the column.   

 

 

 

From the menu, select Make Column Autostretch.  
Dreamweaver will want to create a “spacer” image for 
the autostrech column.  Select the option to create a 
spacer image and save the image within your site.   

 

Rollover Images 
A Rollover image consists of two states, a display state and a rollover state.  The display state is 
how the image appears when the user visits the web page.  The rollover state will only change 
when the user moves the cursor over the 
image.  The Rollover Image icon is 
located in the Common tab on the Insert 
Panel.    
 

 
 


